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Oracle Clinical Development Analytics (Standard Configuration) is an analytical and a 
transactional reporting application. OCDA extracts clinical data on the execution of 
clinical trials from either Oracle Clinical or Siebel Clinical or both, providing a data 
warehouse containing key metrics across the clinical development business process. 
From this warehouse, OCDA provides key pre-defined reports, and enables the 
creation of additional custom reports.

In addition to either Oracle Clinical or Siebel Clinical or both, OCDA requires the 
presence of Informatica PowerCenter, Oracle Business Intelligence Data Warehouse 
Administration Console,  and Oracle Business Intelligence Enterprise Edition (OBIEE), 
and Oracle Database.

1 Intended Audience
This installation guide is intended for users who are responsible for installing Oracle 
Clinical Development Analytics Standard Configuration. You should be familiar with:

■ Oracle Database

■ Oracle Business Intelligence Enterprise Edition (OBIEE) application

■ Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
application

■ Informatica PowerCenter application

2 Before You Begin
This section presents an overview of the OCDA requirements. It also describes the 
tasks that you must complete before you can install the OCDA application. 
Specifically, this section includes the following topics:

■ Technology Stack and System Requirements on page 1

■ Installing the Prerequisite Software on page 4

2.1 Technology Stack and System Requirements
The requisite technology stack for Oracle Clinical Development Analytics Standard 
Configuration is provided in the media pack, with the exception of Informatica. It 
consists of the following products:

■ Oracle Database 11.2.0.2

■  Oracle Containers for J2EE (OC4J) or Oracle WebLogic Server 10.3.3 
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■ Oracle Business Intelligence Enterprise Edition (OBIEE) 10.1.3.4.1 

■ Oracle Business Intelligence Data Warehouse Administration Console 10.1.3.4.1 
and patch 10052370.

■ Informatica PowerCenter 8.6.1 HotFix 11 or 9.0.1 HotFix 2

Installation Considerations
■ Determine the computer on which you will install each component of OCDA 

(Standard Configuration). 

■ You may select to install each product on a different server, if required. The OCDA 
(Standard Configuration) media pack server does not have to act as server for any 
of the products, though it may. You may consult Figure 1, and the documentation 
listed in Table 1 for information on installing each product.

Note: OCDA offers a choice of support for Application Server. You 
can select to have Oracle Containers for J2EE (OC4J) or Oracle 
WebLogic Server 10.3.3 as your Application Server. OC4J is shipped as 
part of OBIEE while Oracle WeLogic Server is available as a separate 
product.

Note: Informatica is not part of the media pack. You need to acquire 
it's license separately. 

All references to media pack server in this document refer to the 
computer onto which you download the media pack for Oracle 
Clinical Development Analytics (Standard Configuration).

Table 1 System Requirements References

Product Reference

Oracle Database 11.2.0.2 Database Installation Guide for <platform>

Oracle Containers for J2EE (OC4J) or Oracle 
WebLogic 10.3.3

Oracle Application Server Documentation or Oracle 
WebLogic Server Documentation Library

Oracle Business Intelligence Enterprise Edition 
(OBIEE) 10.1.3.4.1

System Requirements and Supported Platforms for Ora-
cle Business Intelligence Suite Enterprise Edition

Oracle Business Intelligence Infrastructure Installation 
and Configuration Guide

Oracle Business Intelligence Data Warehouse 
Administration Console 10.1.3.4.1 and patch 
10052370

Oracle Business Intelligence Data Warehouse Adminis-
tration Console Installation, Configuration, and 
Upgrade Guide

Data Warehouse Administration Console User's Guide

Informatica PowerCenter  8.6.1 HotFix11 or 9.0.1 
HotFix 2

Informatica PowerCenter Installation Guide

Other Technology Stack Components My Oracle Support / Certifications

Note: It is important to get the technology stack products from the 
OCDA media pack because newer versions of the technology stack 
products may have become available but may not be compatible with 
OCDA.
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■ Determine the databases you need to create.

■ You must create a database schema to serve as the warehouse for OCDA.

■ If you have already installed OCDA for Plus Configuration, you may not create 
the OCDA schema for Standard Configuration in the same database that has 
Oracle LSH; doing so would create a name collision.

■ It is a good practice to create the schema for the OCDA Standard Configuration 
warehouse in a new database. 

■ You may select to create schemas for repositories for the other OCDA components 
in the same database that will be used for the OCDA warehouse. It minimizes the 
number of databases that you need to maintain for OCDA. However, if you will be 
using the the component applications for purposes other than OCDA, Oracle 
recommends that you create their repositories in instances other than the one 
holding the OCDA warehouse.

Figure 1 Oracle Clinical Development Analytics Technology

For more information about certifications, refer to Finding Certification Information on 
page 17.
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2.1.1 Supported Browsers
OCDA supports those Internet browsers supported by OBIEE. For a list of the 
browsers supported by OBIEE, refer to System Requirements and Supported Platforms for 
Oracle Business Intelligence Suite Enterprise Edition. 

2.2 Installing the Prerequisite Software
Before you can install the OCDA application, you must complete the following 
pre-installation tasks:

❏ Install Oracle Database 11.2.0.2

Follow the instructions in Database Installation Guide for <platform>.

❏ If you have selected to use Oracle WebLogic as the Application Server for OBIEE, 
install Oracle WebLogic 10.3.3.

Follow the instructions in Oracle WebLogic Server Documentation Library.

❏ Install Oracle Business Intelligence Enterprise Edition (OBIEE) 10.1.3.4.1 with the 
following components:

- Oracle Business Intelligence Server (Supported only on Windows and Unix)

- Oracle Business Intelligence Presentation Services (Supported on Windows 
and Unix)

- Oracle Business Intelligence Client Tools (Supported only on Windows)

Follow the instructions in Oracle Business Intelligence Infrastructure Installation and 
Configuration Guide.

❏ Install Oracle Business Intelligence Data Warehouse Administration Console 
(DAC) 10.1.3.4.1

- Install Oracle Business Intelligence Data Warehouse Administration Console 
(DAC)

Follow the instructions in Oracle Business Intelligence Data Warehouse 
Administration Console Installation, Configuration, and Upgrade Guide.

- Install patch number 10052370 

The patch is available in OCDA_HOME/software. Follow the instructions in 
the patch readme to install it.

❏ Install Informatica PowerCenter 8.6.1 HotFix 11 or 9.0.1 HotFix 2

Follow the instructions in Informatica PowerCenter Installation Guide.

3 Oracle Clinical Development Analytics Standard Configuration 
Installation
This section describes the OCDA Installation tasks that you must complete. This 
section includes the following topics:

Note:

Oracle recommends that you enable HTTPS on middle-tier computers 
that are hosting the Web services, since otherwise the trusted user 
name and password that are passed can be intercepted.
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■ Installing Oracle Clinical Development Analytics Standard Configuration on 
page 5

■ Handling Deletions in Siebel Clinical on page 14

3.1 Installing Oracle Clinical Development Analytics Standard 
Configuration 
OCDA  application installation consists of seven components:

■ Preparing the OCDA Warehouse

■ Preparing an Informatica Repository for OCDA

■ Preparing a DAC Repository for OCDA

■ Emplacing the OCDA Help and Image Files

■ Preparing the OBIEE Web Catalog and Repository for OCDA

■ Starting Up OBIEE for OCDA

Perform the following steps to install the OCDA application on Windows and Unix:

3.1.1 Preparing the OCDA Warehouse
You will be using ocda_standard_ddl_scripts.zip,and ocda_standard_cda_packages 
files in this section.

1. Create a database as a container for the OCDA warehouse.

2. Unzip OCDA_HOME/software/ocda_standard_ddl_scripts.zip to create the 
ocda_standard_ddl_scripts folder.

3. Connect to the database as the SYSTEM user.

4. Run ocda_standard_install.sql from OCDA_HOME/software/ocda_standard_
ddl_scripts folder. This script does the following:

a. Create a user called RXI

b. Create a read only user called RXI_RPD

c. Creates all the warehouse tables under RXI

d. Creates synonyms in RXI_RPD for the objects under RXI

Note:

■ The instructions in this section assume that the BI Server and 
Presentation software are installed in <DRIVE>:\oracleBI and 
<DRIVE>:\oracleBIdata, respectively, if on Windows; and in 
/oracleBI and /oracleBIdata, respectively, if on UNIX.

■ All references to ${INFA_INSTALL_DIR}, ${DAC_INSTALL_DIR}, 
and ${MEDIA_PACK} in this document refer to Informatica 
installation folder, DAC installation folder, and Media Pack folder 
respectively.

■ If you install any part of the technology stack on other computers, 
you need to copy the relevant software files to those computers, if 
the client is not available on the computer onto which you have 
unloaded the Media Pack
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5. The script prompts for the following:

a. Password to be set for the user/schema 

b. Default tablespace

c. Default temporary tablespace

Default_Table_Space name. Enter any valid tablespace name for the user as the 
default tablespace.

The script also prompts for the RXI and RXI_RPD user passwords. Enter a valid 
password and continue. 

6. Inspect the following log files, for errors, located in the working folder:

■ ocda_rxi_schema_creation.log

■ ocda_rxi_rpd_schema_creation.log

■ ocda_standard_ddl.log

■ ocda_table_grants.log

■ ocda_synonyms_creation.log

7. Connect to the database as the new user RXI with the following credentials:

 Username: RXI

 Password: Enter the same password entered in the step 5.

8. Unzip OCDA_HOME/software/ocda_standard_cda_packages.zip to create the 
cda_standard_cda_packages folder. From that folder, run the following scripts:

■ OCDA_DUALG_POP.SQL

■ OCDA_S_DUAL_D_POP.SQL

■ OCDA_ETL_RUN_S_POP.SQL

■ OCDA_SC_PARTY_HIERARCHY_PRG.SQL

■ OCDA_W_RXI_LOV_S_seed.sql  

These scripts create OCDA specific packages and the requisite seed data for 
OCDA application in the database. 

3.1.2 Preparing an Informatica Repository for OCDA
You will be using ocda_standard_informatica_mappings.zip file in this section.

1. Unzip ocda_standard_informatica_mappings.zip to create a ocda_standard_
informatica_mappings folder. 

2. Create a new Informatica repository, or login to an existing Informatica repository, 
through Repository Manager as Administrator and create the following folders: 

■ SDE_OC_46_CDA_Adapter - contains SDEs that fetch data from Oracle 
Clinical.

■ SDE_SBL_81_CDA_Adapter - contains SDEs that fetch data from Siebel 
Clinical.

■ SILOS_CDA - contains SILs that load the data from staging tables to the 
warehouse.
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3. Import the following files, from the ocda_standard_informatica_mapping folder, 
containing Informatica objects into their respective folders: 

4. Perform the following to create the Relational Connections for Source and Target 
Databases in Informatica Workflow Manager: 

a. In Informatica PowerCenter Workflow Manager, select Connections, then 
select Relational to display the Relational Connection Browser.

b. Click New to display the Select Subtype dialog.

c. Select Oracle as database type, then click OK. The Connection Object 
Definition dialog box is displayed with options for the selected database 
platform.

d. Enter values in the following fields according to Source and Target database 
connection:

User Name — Enter the user name.

Password — Enter the database password.

Connection String — Enter the Connect string for connecting to the database.

5. Connect to Informatica PowerCenter Administration Console.

6. Connect to the Informatica integration service.

7. Navigate to the Custom Properties window. 

8. Enter AggSupprtWithNoPartLic in the Name field. 

9. Enter Yes in the Value field. 

3.1.3 Preparing a DAC Repository for OCDA
You will be using ocda_standard_dac_metadata.zip file in this section.

1. Create a new DAC repository, or connect to an existing DAC repository, as 
Administrator. 

2. Unzip OCDA_HOME/software/ocda_standard_dac_metadata.zip onto the 
computer where you will run DAC client.

3. Import the OCDA Warehouse Application metadata.

Table 2 Files Containing Informatica Objects

XML File Folder

SDE_OC_46_CDA_Adapter.XML SDE_OC_46_CDA_Adapter 

SDE_SBL_81_CDA_Adapter.XML SDE_SBL_81_CDA_Adapter 

SILOS_CDA.XML SILOS_CDA 

Note: These values will also be required in setting up DAC. Make 
note of them to ensure that you enter the same  during DAC setup.

Important: You need to repeat step a through d for each required 
source and target connection.
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a. Start the Data Warehouse Administration Console (DAC) client.

b. From the Tools menu select DAC Repository Management, and then select 
Import.

c. Click Change import/export folder to navigate to the folder where you 
unzinpped ocda_standard_dac_metadata.zip in step 2 of Section 3.1.3, 
Preparing a DAC Repository for OCDA .

d. Click OK to display the Import dialog box.

e. Select the following categories of metadata you want to import: Logical, 
Overwrite log file, and User Data.

f. Select CDA_Warehouse application in the ApplicationList.

g. Click OK.

h. Enter the verification code and Yes in the secondary window that is displayed 
after the import. 

i. You can inspect the import log in  ${DAC_ INSTALL_DIR }\log\import.log to 
verify if import is successful.

4. Configure Informatica Repository Service in DAC.

a. Navigate to the Setup view, then select the Informatica Servers tab.

b. Click New to display the Edit tab below or select an existing Informatica 
server from the list.

If you are configuring a new installation, the Informatica Servers tab will be 
empty. If you are upgrading an existing installation, the Informatica Servers 
tab might contain existing Informatica servers.

c. Enter values in the following fields:

Name — Enter the Logical name for the Informatica server (for example, 
INFO_REP_SERVER).

Type  — Select Repository.

Server Hostname  — Enter the host machine name where Informatica Server 
is installed.

Server Port  — Enter the port number   Informatica Server or Informatica 
Repository Server use to listen to requests. 

Login — Enter the Informatica user login.

Password — Enter the Informatica Repository password.

Repository Name —Enter the Informatica Repository Name.

d. Test the connection to verify the settings.

e. Click Save to save the details.

5. Configure Informatica Integration Service in DAC.

Note: Make sure that you use the same Login and Password that you 
have used in setting up Informatica.
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a. Click New to display the Edit tab below or select an existing Informatica 
server from the list.

If you are configuring a new installation, the Informatica Servers tab will be 
empty. If you are upgrading an existing installation, the Informatica Servers 
tab might contain existing Informatica servers.

b. Enter values in the following fields:

Name — Enter the Logical name for the Informatica server (for example, 
INFO_SERVER).

Type  — Select Informatica.

Domain — Enter the Informatica domain name.

Login — Enter the Informatica Repository user login.

Password — Enter the Informatica Repository password.

Repository Name —Enter the Informatica Repository Name.

c. Test the connection to verify the settings.

d. Click Save to save the details.

6. In this step, you configure source databases (Oracle Clinical,  Siebel Clinical) and 
the target database (the OCDA warehouse). For each database with which DAC 
will interact for OCDA, perform the following steps:

a. Navigate to the Setup view, then select the Physical Data Sources  tab.

b. Click New to display the Edit tab below or select an existing database 
connection from the list.

c. Enter values in the following fields:

Name — Enter the Logical name for the database connection.

Type  — Select Source when you create the database connection for a 
transactional (OLTP) database. Select Warehouse when you create the 
database connection for a data warehouse (OLAP) database.

Connection Type — Select a connection type for the database connection.

Instance or TNS Name — Enter the Data Mart database instance name.

Table Owner — Enter the Data Mart schema name. 

Table Owner Password — Enter the Data Mart schema password.

DB Host — Enter the Data Mart host name.

Port — Enter the Data Mart host port.

Dependency Priority — Enter the user-defined priority of the data source.

Data Source Number — Enter the user-defined number of the data source.

Num Parallel Indexes Per Table — Enter a number to specify how many 
indexes are to be created in parallel. 

d. Test the connection to verify the settings.

e. Click Save to save the details.

7. Perform the following steps to modify $DBConnection_OC_OLTP and 
$DBConnection_SC_OLTP and $DBConnection_OLAP
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a. Navigate to the Execute view, then select the Execution Plans tab.

b. If Oracle Clinical and Siebel Clinical are your source systems , select CDA - 
Complete Warehouse from the list. 

If Oracle Clinical is your only source system, select CDA - Oracle Clinical 
Warehouse from the list. 

If Siebel Clinical is your only source system, select CDA - Siebel Clinical 
Warehouse from the list. 

c. Click Parameters subtab in the bottom pane.

d. Select a new data source name from the Value list for $DBConnection_OC_
OLTP or $DBConnection_SC_OLTP and $DBConnection_OLAP.

e. Click Save.

8. Perform the following steps in DAC to run the CDA - Complete Warehouse 
Execution Plan. 

a. Navigate to the Execute view, then select the Execution Plans tab.

b. Select OCDA - Complete Warehouse from the list. 

c. Display the Parameters tab.

d. Enter 1 as value for number of copies of parameters, and click Generate.

e. On the Execution Plans tab, click Build.

f. On the Execution Plans tab, click Run Now to execute the ETLs.

DAC Configurable Parameters
Following is the list of DAC configurable parameters:

Note: If Oracle Clinical and Siebel Clinical are your source systems , 
use CDA - Complete Warehouse.

If Oracle Clinical is your only source system, use  CDA - Oracle 
Clinical Warehouse.

If Siebel Clinical is your only source system, use CDA - Siebel Clinical 
Warehouse.

Table 3 DAC Configurable Parameters

Parameter Description

START_TS This is last refresh time of the source tables 
minus prune days.

END_TS Current Execution Plan’s actual start time 
adjusted adjusted to source database timezone 
minus prune days.

DATASOURCE_NUM_ID The ID associated with every source system. 
The default ID is 1 for Oracle Clinical and 2 for 
Siebel Clinical.

TENANT_ID The ID associated for every tenant. The default 
value is 0.
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3.1.4 Emplacing the OCDA Help and Image Files 
You will be using ocda_help_html.zip and ocda_images.zip files in this section.

3.1.4.1 Placement of Files for Oracle Containers for J2EE (OC4J) Application Server  You need 
to manually deploy OCDA’s help and images files on OC4J. Perform the following 
steps:

1. Unzip ocda_help_html.zip and ocda_images.zip in:

■ Windows32 -  <DRIVE>:\OracleBI\web\app\res\s_oracle10\

■ UNIX - /OracleBI/web/app/res/s_oracle10/

2. Unzip ocda_help_html.zip and ocda_images.zip in:

■ Windows32 -  
<DRIVE>:\OracleBI\{webserver}\home\applications\analytics\analytics\re
s\s_oracle10\

■ UNIX - 
/OracleBI/{webserver}/home/applications/analytics/analytics/res/s_
oracle10/

See Also:

■ Oracle Application Server Documentation 

3.1.4.2 Placement of Files for Oracle WebLogic Managed Server  You need to manually 
deploy OCDA’s help and images files on Oracle WebLogic Managed Server. Perform 
the following steps:

1. Stop the Oracle WebLogic Server.

2. Navigate to <OBIEE_HOME>\web and extract analytics.war to the same location.

<OBIEE_HOME> is the OBIEE installation folder.

3. In a temporary staging location, unzip the help and images files.

4. Copy the help and images folders to the following locations:

■ <OBIEE_HOME>\web\app\res\s_oracle10

■ <OBIEE_HOME>\web\analytics\res\s_oracle10

5. Start Administration Server for Oracle WebLogic Server Domain.

6. Start Node Manager.

7. Launch Admin Serve Console.

This opens the Oracle WebLogic Server Administration Console.

DELETE_FLOW The default value is N and set it to Y if Deletes 
have to be captured in the data warehouse.

MATCH_MERGE_FLOW The default value is N and set it to Y if match 
and merge functionality is required.

Prune Days This is used for setting START_TS and  END_
TS for incremental load.

Table 3 (Cont.) DAC Configurable Parameters

Parameter Description
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8. Log in to Oracle WebLogic Server Administration Console.

9. In the left pane of the Administration Console, select Deployments.

10. In the right pane, click Install.

This opens the Install Application Assistant.

11. In Path, enter the path as <OBIEE_HOME>\web

where:

<OBIEE_HOME> is the OBIEE installation folder.

12. Select analytics and click Next.

13. In Choose targeting style, select Install this deployment as an application and 
click Next.

14. In Available targets for analytics, select the servers in the cluster on which you 
want to deploy OCDA.

15. Click Next.

16. In the General section, enter the name of this deployment as analytics.

17. In the Security section, select DD Only: Use only roles and policies that are 
defined in the deployment descriptors.

18. In the Source accessibility section, select I will make the deployment accessible 
from the following location, and enter the following path in Location:

<OBIEE_HOME>\web\analytics

19. Click Next.

20. Select Yes, take me to the deployment's configuration screen and click Finish.

21. Start all the servers in the clusters.

22. Start the following servers:

■ Oracle BI Java Host

■ Oracle BI Presentation Server

■ Oracle BI Server

23. Select the analytics deployment.

24. Click the Testing tab.

The Test Point column lists the links.

25. Click on all the links in the Test Point column.

See Also:

■ Oracle WebLogic Server Documentation Library

3.1.5 Preparing the OBIEE Web Catalog and Repository for OCDA
You will be using ocda_obiee_webcat.zip and ocda_obiee_repository.rpd files in this 
section.

1. Unzip ocda_obiee_webcat.zip in the following folder: 

■ Windows32 -  <DRIVE>:\OracleBIData\web\catalog

■ UNIX  - /OracleBIData/web/catalog
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2. Modify the catalog path line of the following file to point it to the Web Catalog::

■ Windows32 -  <DRIVE>:\OracleBIData\web\config\instanceconfig.xml 

■ UNIX -  OracleBIData/web/config/instanceconfig.xml

For example, 

■ Windows32 - 
<CatalogPath><DRIVE>:\OracleBIData\web\catalog\OCDA</Catal
ogPath>

■ Unix- 
<CatalogPath>/OracleBIData/web/catalog/OCDA</CatalogPath>

3.  Navigate to<OracleBIData>\web\config.

4. Add the following setting after </AdvancedReporting> tag in the 
instanceconfig.xml file:  

<ReportAggregateEnabled>true</ReportAggregateEnabled>

5. Place the ocda_obiee_repository.rpd in the following folder:

■ Windows32 -  <DRIVE>:\OracleBI\server\Repository

■ UNIX  - OracleBI/server/Repository 

6. Take a backup of the NQSConfig.INI file, found in the following locations:

■ Windows32 -  <DRIVE>:\OracleBI\server\Config\NQSConfig.INI

■ UNIX  - /OracleBI/server/Confi/NQSConfig.INI

In the Repository section of the NQSConfig.INI file, set the value of Star to ocda_
obiee_repository.rpd

Star=ocda_obiee_repository.rpd,DEFAULT;

7. Create an ODBC entry for the warehouse.

8. In the Open dialog box, select the OracleBI\server\Repository\ocda_obiee_
repository.rpd (use forward slashes for Unix).  Enter the following credentials: 

 Username: Administrator

 Password: {blank}

9. Click OK to login.

10. Modify the connection pools in the RPD as following:

a. In the physical layer, expand the OCDA Data Warehouse node and 
double-click Connection Pool object to open Connection Pool dialog box. 

b. Set Data source name field to the ODBC entry for the warehouse.

c. Change the username to the username of the OCDA read-only schema.

d. Change the password to the password of the OCDA read-only schema. 

11. From the File menu, select Save to save the rpd. 

Note: You should change the default password using the Oracle 
Business Intelligence Administration Tool. For more information, refer 
to Oracle Business Intelligence Server Administration Guide.
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3.1.6 Starting Up OBIEE for OCDA
1. Start the Web Server (OC4J or WebLogic).

2. Open the Windows Services dialog boxControl Panel > Administration Tools > 
Services.

3. Start the following services:

■ Oracle BI Java Host

■ Oracle BI Server 

■ Oracle BI Presentation Server

4. Start a Presentation Server browser session by selecting  All Programs > Oracle 
Business Intelligence > Presentation Services from the Windows Start menu.

3.2 Handling Deletions in Siebel Clinical
OCDA provides an optional feature to manage hard deletion of records in Siebel 
Clinical. You create triggers in the source system to handle deletion of records. To do 
this:

1. Navigate to the temporary staging location where the OCDA installer copies the 
installation files.

2. Connect to the Siebel Clinical data source and run the OCDA_
HOME/software/ocda_sc_del_triggers.sql script delivered with OCDA. This 
script creates the RXI_DELETE_LOG_S table and triggers on tables provided as 
input. The following are the tables in Siebel Clinical for which OCDA supports 
creating triggers:

■ S_CL_PTCL_LS

■ S_PROD_INT

■ S_CL_SUBJ_LS

■ S_CONTACT

■ S_CL_PGM_LS

■ S_PTCL_SITE_LS

■ S_EVT_ACT

Provide a list of comma separated values of table names for which the triggers 
needs to be created as the script's input. For example, S_CL_PTCL_LS,S_PROD_
INT,S_CL_SUBJ_LS. The tables names that you provide can only be a subset of the 
tables listed above.

For information on how to handle deletion of records in Siebel Clinical, refer to Oracle 
Clinical Development Analytics User and Administrator Guide (Chapter 5, Extract 
Transform Load Programs).

Note: Make note of the URL. This will be the URL you distribute to 
users, for them to use OCDA's dashboards.
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4 Migrating from OCDA 2.0.0.3 (Plus Configuration) to OCDA 
2.0.03 (Standard Configuration)
Since there is no release of OCDA in the Standard Configuration prior to 2.0.0.3, there 
is no upgrade from a prior Standard Configuration.

If you are migrating from OCDA 2.0.0.3 (Plus Configuration) to OCDA 2.0.03 
(Standard Configuration), perform the following steps:

1. Install OCDA 2.0.0.3 (Standard Configuration)

2. If you made any modifications to database tables or ETL System Dependent 
Extract (SDE) or System Independent load (SIL) in your Plus Configuration, apply 
the same changes to their counterparts in the Standard Configuration (Informatica 
PowerCenter and DAC).

3. Perform an initial load of data from the transactional source(s). You can do this in 
two ways:

Option A

a. Create a datamart in the Oracle LSH database, export it from Oracle LSH, and 
then import it into the Standard Configuration warehouse. 

b. Connect to DAC repository, navigate to the Setup tab and Physical Data 
Sources subtab.

c. Select the source system(s) and navigate to Refresh Date subtab.

d. Reset the dates to the last ETL run date in the Plus Configuration, and click 
Save.

e. Run the Execution Plan.

This performs incremental load, bringing the warehouse up to date.

Option B

a. Perform a full load of the warehouse using CDA- Warehouse Execution Plan.

You can refer to "Defining Data Marts" in the Oracle Life Sciences Data Hub Application 
Developer's Guide for steps for creation of data mart.  When you define the LSH 
datamart, include all of the tables in the warehouse which are populated by OCDA 
ETL.

5 Related Documents
For more information, see the following documents in the Oracle Business Intelligence 
Data Warehouse Administration Console 10.1.3.4.1 documentation set and the Oracle 
Business Intelligence Enterprise Edition Release 10.1.3.4.1 documentation set.

Oracle Business Intelligence Data Warehouse Administration Console (DAC) Documentation
The Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
documentation set includes: 

■ Oracle Business Intelligence Data Warehouse Administration Console User's Guide (Part 
E12652)

■ Oracle Business Intelligence Data Warehouse Administration Console Installation, 
Configuration, and Upgrade Guide (Part E12653)
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Oracle Business Intelligence Enterprise Edition (OBIEE) Documentation
The Oracle Business Intelligence Enterprise Edition (OBIEE) documentation 
set includes: 

■ System Requirements and Supported Platforms for Oracle Business Intelligence Suite 
Enterprise Edition (Part E10417)

■ Oracle Business Intelligence Infrastructure Installation and Configuration Guide (Part 
E31765)

■ Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards User Guide 
(Part B31767)

■ Oracle Business Intelligence Presentation Services Administration Guide (Part B31766)

■ Oracle Business Intelligence Server Administration Guide (Part B31700)

■ Oracle Business Intelligence Web Services Guide (Part B31769)

6 Finding Information and Patches on My Oracle Support
Your source for the latest information about Oracle Clinical Development Analytics 
Standard Configuration is Oracle Support's self-service Web site, My Oracle Support 
(formerly MetaLink). 

Always visit the My Oracle Support Web site for the latest information, including 
alerts, release notes, documentation, and patches.

6.1 Creating a My Oracle Support Account
You must register at My Oracle Support to obtain a user name and password account 
before you can enter the Web site.

To register for My Oracle Support:

1. Open a Web browser to http://support.oracle.com.

2. Click the Register here link to create a My Oracle Support account. The 
registration page opens. 

3. Follow the instructions on the registration page.

6.2 Signing In to My Oracle Support
To sign in to My Oracle Support:

1. Open a Web browser to http://support.oracle.com.

2. Click Sign In.

3. Enter your user name and password.

4. Click Go to open the My Oracle Support home page.

6.3 Searching for Knowledge Articles by ID Number or Text String
The fastest way to search for product documentation, release notes, and white papers 
is by the article ID number.

To search by the article ID number:

1. Sign in to My Oracle Support at http://support.oracle.com.
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2. Locate the Search box in the upper right corner of the My Oracle Support page.

3. Click the sources icon to the left of the search box, and then select Article ID from 
the list.

4. Enter the article ID number in the text box.

5. Click the magnifying glass icon to the right of the search box (or press the Enter 
key) to execute your search.

The Knowledge page displays the results of your search. If the article is found, 
click the link to view the abstract, text, attachments, and related products.

In addition to searching by article ID, you can use the following My Oracle Support 
tools to browse and search the knowledge base:

■ Product Focus — On the Knowledge page, you can drill into a product area 
through the Browse Knowledge menu on the left side of the page. In the Browse 
any Product, By Name field, type in part of the product name, and then select the 
product from the list. Alternatively, you can click the arrow icon to view the 
complete list of Oracle products and then select your product. This option lets you 
focus your browsing and searching on a specific product or set of products.

■ Refine Search — Once you have results from a search, use the Refine Search 
options on the right side of the Knowledge page to narrow your search and make 
the results more relevant.

■ Advanced Search — You can specify one or more search criteria, such as source, 
exact phrase, and related product, to find knowledge articles and documentation.

6.4 Finding Patches on My Oracle Support
Be sure to check My Oracle Support for the latest patches, if any, for your product. You 
can search for patches by patch ID or number, or by product or family.

To locate and download a patch:

1. Sign in to My Oracle Support at http://support.oracle.com.

2. Click the Patches & Updates tab. 

The Patches & Updates page opens and displays the Patch Search region. You have 
the following options:

■ In the Patch ID or Number is field, enter the primary bug number of the patch 
you want. This option is useful if you already know the patch number.

■ To find a patch by product name, release, and platform, click the Product or 
Family link to enter one or more search criteria.

3. Click Search to execute your query. The Patch Search Results page opens.

4. Click the patch ID number. The system displays details about the patch. In 
addition, you can view the Read Me file before downloading the patch.

5. Click Download. Follow the instructions on the screen to download, save, and 
install the patch files.

6.5 Finding Certification Information
Certifications provide access to product certification information for Oracle and third 
party products. A product is certified for support on a specific release of an operating 
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system on a particular hardware platform, for example, Oracle Database 10g Release 2 
(10.2.0.1.0) on Sun Solaris 10 (SPARC). To find certification information: 

1. Sign in to My Oracle Support at http://support.oracle.com.

2. Click the Certifications tab. The Certifications page opens and displays the Find 
Certifications region.

3. In Select Product, enter Oracle Clinical Development Analytics.

4. Click the Go to Certifications icon.

The right pane displays the certification information.

5. Select a certification to view the certification details.

7 Finding Documentation on Oracle Technology Network
You can also use the Oracle Technology Network Web site to open PDF versions of 
user and reference documentation.

Visit the Oracle Technology Network Web site at the following address:

http://www.oracle.com/technology/index.html

Use the Documentation menu and the Documentation Index to find the manual you 
want, and then click its title to download and open the PDF version of the manual.

8 Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call 
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle 
technical issues and provide customer support according to the Oracle service request 
process. Information about TRS is available at 
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http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone 
numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.
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